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PENDAHULUAN 

 

 

Dokumen BIM: Manual Penggunaan Templat JKR Mekanikal merupakan satu 

dokumen di peringkat jabatan yang menerangkan tentang tatacara penggunaan 

Templat BIM JKR Mekanikal kepada pegawai yang terlibat dalam reka bentuk 

mekanikal projek yang dilaksanakan secara BIM. Sebahagian keterangan 

penggunaan templat ini adalah sebagai panduan kepada pengguna dan ianya boleh 

diubahsuai mengikut keperluan dan kesesuaian. 

 

Dengan adanya dokumen BIM: Manual Penggunaan Templat JKR Mekanikal ini, 

diharapkan agar pembangunan model dapat dilaksanakan dengan lebih teratur 

berdasarkan Manual Proses Kerja BIM JKR dan faedah penggunaan BIM dapat 

dimanfaatkan sepenuhnya di dalam sesebuah projek. 

 

Dokumen ini adalah terpakai untuk semua projek yang direkabentuk secara 

konvensional dalaman (in-house) sahaja. Bagi projek yang direka bentuk oleh 

perunding atau reka dan bina, dokumen ini boleh juga digunakan sebagai rujukan 

mengikut mana yang bersesuaian. 

 

Akhir sekali, diharapkan agar isi kandungan dokumen ini dapat memberi kefahaman, 

pengetahuan dan maklumat berguna kepada semua pihak dalam merealisasikan 

proses kerja BIM yang lebih terancang, meningkatkan kompetensi para pegawai serta 

memberi nilai tambah kepada sistem penyampaian projek. 
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ISTILAH KETERANGAN 

Building 
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Proses penyediaan dan penggunaan model menerusi 

teknologi digital 3D berparametrik yang mengandungi 

informasi bagi meningkatkan sistem penyampaian di 

sepanjang kitar hayat pelaksanaan projek 

Component 

Families 

Elemen Family yang dimuat naik ke dalam perisian model bagi 

tujuan penyediaan model seperti Tangki, Pintu dan Columns 

Family 

Merupakan salah satu elemen model 3D berparametrik yang 

digunakan dalam penghasilan model dan mengandungi 

pelbagai parameter 

Legends 
Komponen yang digunakan untuk memaparkan simbol yang 

mewakili elemen model 

Level Istilah bagi aras yang digunapakai di dalam perisian Revit 

Link Model 
Proses menghubungkan model daripada disiplin lain bagi 

tujuan rujukan penyediaan model 

Model 3D 
Satu gambaran tiga dimensi bangunan dan/atau struktur yang 

dihasilkan daripada aplikasi BIM 

Naviswork 
Perisian yang digunakan bagi melaksanakan penyelarasan 

reka bentuk, clash analysis dan simulasi 

Parameter 
Medan informasi di dalam elemen yang mengandungi data 

geometri dan bukan geometri 

Project 

Information 
Parameter maklumat projek yang terdapat di dalam model 

Revit Perisian yang digunakan bagi membangunkan model BIM 

Revit Template 
Tetapan piawaian perisian Revit yang dibangunkan bagi tujuan 

keseragaman dan mempercepatkan proses penyediaan model  

Schedules 
Jadual Kuantiti Bahan Binaan dan peralatan / kelengkapan 

bangunan yang dijana daripada model  
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MANUAL PENGGUNAAN TEMPLAT BIM JKR REVIT MEKANIKAL 

 

1 PENGENALAN DOKUMEN 

Dokumen Manual Penggunaan Templat (MPT) Building Information Modeling (BIM) 

Jabatan Kerja Raya (JKR) Revit Mekanikal merupakan satu dokumen di peringkat 

jabatan yang bertujuan bagi memberikan panduan mengenai bagaimana 

menggunakan Templat BIM JKR Revit Mekanikal kepada Jurutera Mekanikal / 

Penolong Jurutera Mekanikal JKR khususnya yang terlibat dalam projek yang 

dilaksanakan secara BIM. Dokumen ini menerangkan pengenalan, fungsi dan 

penggunaan templat yang disediakan oleh Unit BIM Cawangan Perancangan Aset 

Bersepadu (CPAB) JKR. 

 

2 KONSEP PENGGUNAAN TEMPLAT BIM JKR REVIT MEKANIKAL 

Templat BIM JKR Revit Mekanikal telah dibangunkan dalam format .rte melalui 

perisian Revit. Templat ini disediakan dengan tetapan-tetapan dan bahagian-

bahagian umum yang lazim digunakan di dalam pembangunan Model Sistem 

Mekanikal. 

BIM Modeler akan menggunakan templat ini dalam proses pembangunan dan 

pengemaskinian Model Sistem Mekanikal. Semua maklumat rekabentuk, pembinaan 

dan aset akan diisi di dalam ruang yang terdapat di dalam templat yang disediakan.  

Selain itu, templat ini juga boleh diubahsuai mengikut kesesuaian dan keperluan 

projek. Walau bagaimanapun, perkara ini perlu dirujuk atau dimaklumkan kepada Unit 

BIM sekiranya terdapat keperluan tambahan terhadap tetapan sedia ada di dalam 

templat. 

Rajah 1 di bawah memberikan gambaran lanjut mengenai carta alir umum konsep 

penggunaan Templat Mekanikal BIM JKR. 
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CARTA ALIR UMUM KONSEP PENGGUNAAN TEMPLATE BIM JKR (MEKANIKAL)
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Muat naik 

Template BIM 

.rte terkini ke 

dalam Pusat BIM

Muat turun 

Template BIM 

.rte ke dalam 

Folder Projek

Serah Templat 

BIM .rte & 

Rekod

Terima 

Templat BIM, 

.rte

Semak 

Kesesuaian 

Template dengan 

Projek

Perlu

Perubahan Project

Browser?

Perlu

Perubahan Tetapan 

Sistem Mekanikal?

Laksana 

Perubahan 

Project Browser

Ya

Tidak

Mula Pemodelan 

Model BIM 

Mekanikal

Mohon 

Perubahan 

Tetapan

Ya

Kaji kesesuaian 

perubahan 

tetapan

Terima 

Permohonan 

& Rekod

MULA

TAMAT

Perlu

Perubahan 

Tetapan

Laksana 

Perubahan 

Tetapan & Rekod

Ya

Serah 

Maklumbalas 

Kajian & Rekod

Tidak

Terima 

Maklumbalas 

Kajian

 

Rajah 1 : Carta alir umum konsep penggunaan Templat BIM JKR Revit Mekanikal 
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2.1 Penggunaan Templat Mekanikal 

ATURAN DAN KETERANGAN BERGAMBAR 

Memilih Templat BIM JKR Revit Mekanikal untuk memulakan projek. 

i) Klik [1] New > Klik [2] Browse 

  

 

 

 

 

 

 

 

 

[1] 

[2] 

 

[5] 
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i) Pilih dan Klik [3] Templat BIM JKR Revit Mekanikal > Klik [4] Open 

ii) Klik [5] OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[3] 

[4] 
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Rajah 2 : Paparan Muka Perisian Revit menggunakan Templat BIM JKR Revit 
Mekanikal 

 

Rajah 2 menunjukkan paparan muka perisian Revit dan penerangannya adalah seperti di bawah: 

No.  Penerangan   No. Penerangan 

1. Application button  8. Properties pallete 

2. Quick access toolbar  9. Steering wheels navigation 

3. Info center  10. Drawing area 

4. Tab  11. View control bar 

5. Panel  12. Status bar 

6. Ribbon  13. Options bar 

7. Project browser 

 

 

 

 

 

 

 
[1] 

  

[2] [3] 

 
[4] 

` 
[5] 

 [6] 

[7] 

[8] 

` 

[11] 

[9] ` 

[10] 

` 

[12] 

` 

[13] 
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3 TEMPLAT BIM JKR REVIT MEKANIKAL 

 

3.1 Templat Projek Mekanikal 

Templat ini digunakan sebagai templat permulaan bagi projek baru sistem mekanikal. 

Tempat projek ini mengandungi paparan yang telah ditentukan mengikut kesesuaian 

projek JKR pada sebahagian Revit Interface seperti Properties dan Project Browser 

serta pengubahsuaian pada tetapan seperti View Templates, Mechanical Settings dan 

lain-lain seperti mana yang akan diterangakn di dalam dokumen ini. Templat ini juga 

perlu dikemaskini dan dinaiktaraf dari semasa ke semasa mengikut kesesuaian 

pelaksanaan reka bentuk sistem mekanikal dan versi terkini Autodesk Revit. 

 

 

Rajah 3 : Contoh Templat BIM JKR Revit Mekanikal 
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4 PROJECT INFORMATION 

4.1 Pengenalan Project Information  

Project Information mengandungi informasi yang perlu dimasukkan ke dalam model 

sesebuah projek seperti nama dan alamat projek, status projek, nama dan alamat 

pelanggan, tarikh pelaksanaan projek dan lain-lain. 

Informasi yang terkandung di dalam Project Information juga boleh dimasukkan ke 

dalam jadual dan digunakan pada Title Block (Sheet). 

 

4.1.1 Project Information Interface 

ATURAN DAN KETERANGAN BERGAMBAR 

Aturan untuk membuka Project Information Interface adalah seperti berikut: 

i) Klik [1] tab Manage > [2]  Project Information (pada panel Settings) 

  

 

Rajah 4 : Contoh Project Information Interface 

 

 

[1] [2] 
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4.2 Fungsi Project Information  

Fungsi Project Information adalah untuk menyimpan maklumat projek. Sebahagian 

maklumat berkaitan Model Mekanikal yang hendak disimpan diambil daripada 

maklumat sedia ada di dalam Model Arkitek dan juga dikunci masuk oleh pengguna. 

Tatacara bagi menyalin maklumat sedia ada daripada Model Arkitek dan tatacara bagi 

mengunci masuk maklumat baru ke dalam Project Information Model Mekanikal 

adalah seperti di bawah: 

 

4.2.1 Menyalin Maklumat Sedia Ada Projek Daripada Model Arkitek                               

( Transfer Project Standards ) 

Aturan dan keterangan bergambar 

Memilih maklumat di dalam Project Info dan Project Parameter dalam Model 

Arkitek yang hendak disalin. 

i) Klik [1] tab Manage > [2]  Transfer Project Standards (pada panel 

Settings) 

 

ii) Pilih [3] Project Info > [4] Project Parameter > Klik [5] OK 

 

 

 

[1] 

[2] 

 

[3] 

 

[4] 

 

[5] 
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Aturan dan keterangan bergambar 

iii) Paparan maklumat [6] yang telah disalin. 

 

 

 

 

 

 

 

 

 

 

 

[6] 
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4.2.2 Mengisi Maklumat Disiplin Mekanikal ke dalam Model Mekanikal 

 

Aturan dan keterangan bergambar 

 

Rajah 5 : Paparan maklumat yang telah lengkap diisi 
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5 MECHANICAL SETTINGS 

5.1 Pengenalan Mechanical Settings 

Mechanical Settings digunakan untuk menentukan parameter asas dan nilai tetapan 

asal bagi System Family mekanikal.  

Tetapan parameter yang ditentukan pada Mechanical Settings di dalam templat ini 

adalah bagi System Family seperti Pipe dan Duct berdasarkan kepada spesifikasi 

JKR. 

 

5.1.1 Mechanical Settings Interface  

Aturan dan keterangan bergambar 

Aturan untuk membuka Mechanical Settings Interface adalah seperti berikut: 

i) Klik [1] tab Manage > [2] Klik MEP Settings drop-down > [3] Klik 

Mechanical Settings (pada panel Settings)  

  

 

 

 

 

 

 

 

[2] 

[1] 

 

[3] 
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Aturan dan keterangan bergambar 

 

 

Rajah 6 : Paparan Muka Mechanical Settings 

 

Penetapan bagi perkara-perkara berikut perlu dipastikan terlebih dahulu di dalam 

Mechanical Settings sebelum memulakan kerja-kerja pembangunan model dengan 

menggunakan templat ini: 

i) Penetapan saiz sesalur (duct), Duct Annotation Size dan lain-lain di dalam Duct 

Settings. 

ii) Penetapan saiz paip, Pipe Annotation Size dan sebagainya di dalam Pipe 

Settings. 
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5.2 Tetapan di dalam Mechanical Settings  

Tetapan System Family bagi duct dan pipe telah sedia ditetapkan di dalam templat 

ini. Pengguna hanya perlu menyemak dan memastikan kesediaan tetapan tersebut. 

 

5.2.1 Semakan Tetapan Duct di dalam Mechanical Settings 

Aturan dan keterangan bergambar 

Menyemak tetapan saiz duct 

 

Pada paparan Mechanical Settings Interface;  

Klik [1] Duct Settings > Klik [2] Rectangular > Semak [3] kesemua saiz sesalur 

(duct) sedia ada dan [4] pastikan telah ditandakan > Klik [5] sekiranya ingin 

mewujudkan saiz sesalur (duct) yang baru > Klik [6] OK. 

 

 

 

 

 

[1] 

 

[2] 

 

[3] 

[4] 

 

[6] 

 

 

[5] 
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5.2.2 Semakan Tetapan Paip di dalam Mechanical Settings 

Aturan dan keterangan bergambar 

Menyemak tetapan paip 

 

Pada paparan Mechanical Settings Interface;  

i) Klik [1] Pipe Settings > Klik [2] untuk semak tetapan sedia ada. Tetapan 

boleh diubah pada ruang Value > Klik [3] OK.  

 

 

 

 

 

 

 

[1] 

 

[2] 

 

[3] 
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Aturan dan keterangan bergambar 

ii) Klik [4] Segments and Sizes > Pilih [5] untuk memilih Segment paip sedia 

ada. Contoh: Copper – A > Semak [6] bilangan saiz paip sedia ada dan 

pastikan [7] telah ditandakan > Klik [8] sekiranya ingin mewujudkan segments 

paip yang baru > Klik [9] OK.  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[4] 

 

  

 

[5] 

[7] 

[6] [9] 

 

[8] 
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6 PROJECT BROWSER 

 

6.1 Pengenalan Project Browser 

Project Browser digunakan untuk menunjukkan hierarki views, legends, 

schedules, sheets untuk sesuatu projek. Ia boleh diubah-suai mengikut 

kesesuaian projek. 

Susunan elemen project browser mengikut hierarki adalah seperti berikut: 

i. Views 

ii. Legends 

iii. Schedules / Quantities 

iv. Sheets 

v. Families 

vi. Groups 

vii. Revit Links 

 

 

Rajah 7 : Project Browser Templat Mekanikal 

 

6.1.1 Paparan Project Browser 

Aturan dan keterangan bergambar 

Paparan Project Browser diwujudkan dengan mengikut aturan berikut; 

i) Klik [1] Views Tab > [2] Windows Panel > Klik [3] User Interface 

Drop-Down > Pilih [4] Project Browse 
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Aturan dan keterangan bergambar 

 

 

 

 

6.2 Fungsi Project Browser  

 

Project Browser Fungsi 

Views Memaparkan model elemen daripada pandangan floor 

plans, ceiling plans, 3D dan elevations serta 

mewujudkan paparan sections, detail view dan 

drafting. 

Legends Memaparkan komponen dan simbol yang digunakan di 

dalam model 

Schedules Memaparkan senarai lukisan dan maklumat yang 

dimasukkan ke dalam model seperti maklumat ruang, 

reka bentuk mekanikal, kuantiti dan aset 

Sheets Memaparkan lukisan yang dijana daripada model dan 

dokumentasi perincian yang dimasukkan ke dalam 

projek 

Families Memaparkan senarai komponen yang terdapat di 

dalam fail templat. 

Revit Links Memaparkan senarai model yang dihubungkan kepada 

projek 

Jadual 1 : Fungsi Project Browser 

 

 

[1] 

 

[2] 

 

[3] 

 

[4] 
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6.3 Penggunaan Project Browser 

6.3.1 Views 

Views terbahagi kepada dua bahagian iaitu: 

i. Coordination 

ii. Mechanical 

 

1) Coordination merupakan paparan yang memaparkan elemen 

koordinasi bagi disiplin Architecture, Structural, Mechanical, Electrical 

dan Plumbing. 

 

Coordination Views terbahagi kepada dua (2) bahagian iaitu: 

1. Views 

2. Presentation 

 

1. Views merupakan paparan bagi penjanaan 3D Coordination 

 

2. Presentation merupakan paparan bagi penjanaan Camera, 

Walkthrough dan Render 

 

2) Mechanical merupakan paparan yang memaparkan elemen disiplin 

mekanikal berdasarkan tetapan pada Object Styles. Elemen bagi 

kategori selain daripada disiplin mekanikal akan ditunjukkan dalam 

tetapan halftone. 

Mechanical Views terbahagi kepada enam (6) bahagian iaitu: 

1. Piawaian BIM JKR - Konvesyen Penamaan Mekanikal, 

2. WIP (Work In Progress), 

3. Documentation, 

4. Bomba. 

5. Energy Analysis; dan 

6. Export 

 

1. Piawaian BIM JKR – Konvensyen Penamaan Mekanikal 

merupakan paparan bagi rujukan dalam menentukan penamaan fail 

model mekanikal berdasarkan konvensyen penamaan yang 

dibangunkan di dalam Piawaian BIM JKR dan penerangan kod 

System Type yang digunakan di dalam templat ini. 

 

2. WIP merupakan paparan bagi membangunkan model reka bentuk 

sistem mekanikal. Paparan yang diwujudkan ialah pandangan Floor 

Plans, Ceiling Plans, 3D Views dan Elevations. 
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3. Documentation merupakan paparan bagi penyediaan dokumentasi 

dan telah tersedia untuk dimasukkan ke dalam Sheets. Paparan yang 

diwujudkan ialah pandangan Floor Plans, Ceiling Plans, 3D Views, 

Elevations, Drafting Views, Detail Views dan Section. 

 

4. Bomba merupakan paparan bagi penyediaan dokumentasi kepada 

Bomba dan telah tersedia untuk dimasukkan ke dalam Sheets. 

Paparan yang diwujudkan ialah pandangan Floor Plans, Ceiling 

Plans dan 3D Views. 

 

5. Energy Analysis merupakan paparan bagi penyediaan ruang dan 

zon mekanikal untuk menjana data analisis Heating and Cooling 

Loads. Paparan yang diwujudkan ialah pandangan Floor Plans dan 

3D Views. 

 

6. Export merupakan paparan bagi penyediaan perkongsian model dan 

telah tersedia untuk di eksport kepada format (.nwc). Paparan yang 

diwujudkan ialah pandangan 3D Views. 

 

Mechanical Views mengandungi paparan seperti berikut: 

 

 

Rajah 8 : Hierarki paparan Mechanical Views 
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Views Fungsi 

3D Views Memaparkan pandangan model 3 Dimensi (3D) 

Camera Memaparkan pandangan 3D Perspektif daripada lokasi 

kamera 

Render Memaparkan pandangan 3D photorealistic  

Walkthrough Memaparkan pandangan animasi 3D Walkthroughs 

Floor Plans Memaparkan pandangan model pelan lantai.  

Callout Memaparkan pandangan pelan atau terperinci yang 

menumpukan bahagian yang spesifik atau tertentu. 

Ceiling Plans Memaparkan pandangan model pelan siling 

Elevations Memaparkan pandangan model arah Utara (North), 

Selatan (South), Timur (East) dan Barat (West) 

Sections Memaparkan pandangan model keratan yang 

diwujudkan pada Floor Plans atau Ceiling Plans 

Detail Views Memaparkan paparan model pada skala yang lebih 

terperinci berbanding paparan asal 

Drafting Views Memaparkan paparan nota am, lukisan perincian atau 

maklumat yang berkaitan dengan model sistem 

mekanikal 

Space & Zone Memaparkan pandangan pelan lantai yang 

mengandungi ruang dan zon yang diwujudkan untuk 

menentukan tetapan ruang bagi analisis tenaga. 

Navisworks Memaparkan pandangan model untuk dieksport 

kepada perisian Autodesk Navisworks (.nwc) 

Jadual 2 : Fungsi Views 
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Aturan dan keterangan bergambar 

Mewujudkan Camera / Walkthrough 

i) Klik [1] 3D Views > Klik [2] Camera / Walkthrough pada paparan Floor 

Plans  

 
 

 

 

 

 

 

 

 

 

Aturan dan keterangan bergambar 

Mewujudkan Floor Plans 

ii) Klik [1] Plan Views > Klik [2] Floor Plan untuk mewujudkan paparan Floor 

Plans di dalam Project Browser 

 

 
 

. 

[1] 

. [2] 

. 

[1] 

[2] . 
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Aturan dan keterangan bergambar 

iii) Klik [3] Edit Type > Klik [4] untuk menukar View Template 

   
 

iv) Klik [4] untuk memilih View Template > Klik [5] OK 

 

 

. 

[3] 

. 

[4] 

. 

[4] 

. 

[5] 
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Aturan dan keterangan bergambar 

v) Pilih [6] senarai aras bagi Floor Plan yang perlu diwujudkan > Klik [7] 

OK. 

 
 

 

 

 

 

 

 

 

. 

[6] 

. 

[7] 
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Aturan dan keterangan bergambar 

Mewujudkan Ceiling Plans 

i) Klik [1] Plan Views > Klik [2] Reflected Ceiling Plan untuk mewujudkan 

paparan Ceiling Plans 

 

 

ii) Klik [3] Edit Type > Klik [4] untuk menukar View Template 

 

   
 

. 

[1] 

. 
[2] 

. 

[3] 

. 

[4] 
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Aturan dan keterangan bergambar 

iii) Klik [4] untuk memilih View Template > Klik [5] OK 

 

 
 

iv)  Pilih [6] senarai aras bagi Ceiling Plan yang perlu diwujudkan > Klik [7] 

OK. 

 

 

. 
[4] 

. 

[5] 

. 

[6] 

. 

[7] 
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Aturan dan keterangan bergambar 

Mewujudkan 3D Views / Elevations 

i) Klik (Right Click) [1] pada view yang perlu diwujudkan (3D Views / 

Elevations) > Pilih [2] Duplicate View > Pilih [3] Duplicate with Detailing 

  
 

ii) Klik (Right Click) [4] pada view yang telah diwujudkan > Pilih [5] untuk 

menamakan view > Pilih [6] untuk menentukan view template > Pilih [7] 

untuk memilih view template yang berkenaan > [8] Klik OK. 

 

   
 

 

 

 

 

 

 

 

. 
[2] 

. 

[1] 
[3] 

. 

. 

[4] 

. 

[5] 

. 

[6] 
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Aturan dan keterangan bergambar 

 

 
 

 

Aturan dan keterangan bergambar 

Menggunakan Drafting Views 

 

i) Klik [1] untuk membuka paparan Drafting View > Pilih [2] Link CAD untuk 

menghubungkan lukisan CAD (.dwg) > Pilih [3] untuk memilih lukisan CAD 

> Tentukan [4] tetapan Link CAD > Klik [5] Open. 

   
 

 

. 

[7] 

. 

[8] 

. 

[1] 

. 

[2] 
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Aturan dan keterangan bergambar 

 

 
 

Mewujudkan Drafting Views 

i) Klik [1] untuk mewujudkan paparan Drafting View yang baru > Klik [2] 

untuk menamakan paparan Drafting View > Klik [3] OK 

 

  
 

 
 

 

 

   

 

. 

[1] 

. 

[3] 

. 

[4] 

. 
[5] 

. 

[2] 

. 

[3] 
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Aturan dan keterangan bergambar 

Mewujudkan Sections 

i) Pada view Floor Plans atau Ceiling Plans Klik [1] Section > Pilih [2] Wall 

Section > Klik [3] pada ruang paparan untuk menentukan kedudukan 

segmen dan titik akhir Sections > Klik (Right Click) pada section dan pilih 

[4] Go to View untuk membuka paparan Sections. 

  
 

   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. 

[1] 

. 

[2] . 

[3] 

. 
[4] 
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Aturan dan keterangan bergambar 

Mewujudkan Detail View 

ii) Pada view Floor Plans atau Ceiling Plans Klik [1] Section > Pilih [2] Detail 

> Klik [3] Reference Other View untuk menghubungkan paparan kepada 

drafting view > Pilih [4] untuk memilih paparan drafting view > Klik pada 

ruang paparan untuk menentukan kedudukan segmen dan titik akhir Detail 

View > Klik [5] (Right Click) pada Detail View dan pilih [6] Go to View untuk 

membuka paparan Detail View. 

  
 

     
 

 

 

 

. 

[1] 

. 

[2] 

. 

[3] 

. 

[4] 

. 

. 

[5] 

[6] 
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Aturan dan keterangan bergambar 

Menggunakan Space & Zone 

 

a) Space 

i) Pilih [1] paparan aras space & zone > Klik [2] pada model arkitek (linked file) 

> Klik [3] Edit Type > Pilih [4] Room Bounding untuk menjadikan elemen 

sebagai sempadan ruang bilik yang akan digunakan sebagai rujukan dalam 

pengiraan keluasan dan isipadu bilik. > Klik [5] OK 

  

  
 

   
 

. 
[1] 

. 

[2] 

[3] . 

. 

[4] 

. 

[5] 
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Aturan dan keterangan bergambar 

ii) Klik [6] Space > Pilih [7] untuk memasukkan space ke dalam ruang (semua 

ruang perlu dimasukkan space untuk tujuan analisa tenaga) > Klik [8] Color 

Fill Legend > Klil [9] pada paparan untuk memasukkan Color Fill Legend 

> Klik [10] untuk menamakan space mengikut room name > Pilih [11] 

Names and Number > Klik [12] OK. 

 

     
 

    
 

    
 

. 

[6] 

. 

[7] 

. 

[8] 

. 

[9] 

. 

[10] 

. 

[11] 

. 

[12] 
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Aturan dan keterangan bergambar 

 

 
Rajah 9 : Space Naming 

 

 

b) Zone 

i) Klik [1] Zone > Klik [2] Edit Zone > Klik [3] Add Space > Pilih [4] Space yang 

perlu dimasukkan ke dalam zone yang sama > Klik [5] Finish Editing Zone. 

 

   
 

   
 

. 

[1] 

. 
[2] 

. . 

. 

[5] 

[4] 

[3] 
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Aturan dan keterangan bergambar 

Menggunakan Export Navisworks 

i) Pilih [1] 3D Export untuk membuka paparan > Klik [2] File > Pilih [3] Export 

> Pilih [4] NWC untuk eksport kepada fail Naviswork Cache > Namakan fail 

[5] > Klik [6] Save. 

 

   
 

 
 

 

 

 

. 

[1] 

. 

[2] 

. 

[3] 

. 

. . 

[4] 

[5] [6] 
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6.3.2 Legend 

Legend merupakan paparan yang menunjukkan senarai komponen berserta 

maklumat berkaitan yang digunakan di dalam fail model. Paparan legend ini 

seterusnya akan dimasukkan ke dalam Sheets sebagai rujukan petunjuk kepada 

lukisan yang berkaitan. 

 

6.3.2.1 Menggunakan Legend 

Aturan dan keterangan bergambar 

a) Menjana Legend 

i) Klik [1] Legends jika perlu menambah Legend sedia ada > Pilih [2] 

Legend > Namakan paparan baru Legend [3] > Klik [4] OK.  

   

b) Legend Component 

i) Pilih [1] untuk membuka paparan > Klik [2] Component > Pilih [3] Legend 

Component > Klik [4] untuk memilih jenis komponen > Klik [5] untuk 

memasukkan komponen ke dalam ruang paparan > Klik [6] untuk 

memasukkan text ke dalam ruang paparan. 

 

 

 

 

 

 

 [1] 

  [2] 

 

 

[3] 

  
[4] 
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Aturan dan keterangan bergambar 

   

 

 

c) Draw Legend 

i) Klik [1] Detail Line > Pilih [2] jenis geometri untuk melukis Legend pada 

ruang paparan. 
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6.3.3 Schedules/Quantities 

Schedules/Quantities merupakan paparan untuk menjana maklumat daripada 

fail model. Maklumat yang boleh dijana di dalam jadual adalah bergantung 

kepada kategori jadual dan atribut / parameter yang terdapat di dalam fail model. 

Maklumat yang telah dijana adalah berparametrik dengan elemen daripada 

model yang telah dibangunkan. 

Schedules/Quantities terbahagi kepada 7 bahagian; 

1. Jadual Lukisan 

2. Jadual Maklumat Keperluan Mekanikal 

3. Jadual Reka Bentuk 

4. Jadual Kuantiti Komponen Mekanikal 

5. Jadual Kuantiti Duct 

6. Jadual Kuantiti Pipe 

7. Jadual Rekod Aset 

 

 

Rajah 9 : Hierarki Schedule/Quantities 
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Jadual Fungsi 

Lukisan Memaparkan senarai lukisan yang dijana daripada 

paparan Sheets 

Maklumat Keperluan 

Mekanikal 

Memaparkan maklumat keperluan sistem 

mekanikal yang perlu disediakan oleh disiplin lain 

Reka Bentuk Memaparkan maklumat reka bentuk mekanikal 

seperti ruang, zon dan spesifikasi reka bentuk 

Komponen Mekanikal Memaparkan maklumat kuantiti komponen 

mekanikal yang telah dibangunkan di dalam model 

Duct Memaparkan maklumat kuantiti duct system yang 

telah dibangunkan di dalam model 

Pipe Memaparkan maklumat kuantiti piping system 

yang telah dibangunkan di dalam model 

Rekod Aset Memaparkan maklumat barkaitan pengurusan 

rekod aset yang akan digunakan untuk 

penyenggaraan dan naik taraf 

Jadual 3 : Fungsi Schedule 

 

6.3.3.1 Menggunakan Schedules/Quantities 

Aturan dan keterangan bergambar 

a) Menjana Schedules/Quantities 

i) Klik [1] Schedules jika perlu menambah Schedule/Quantities sedia 

ada > Pilih [2] Schedule/Quantities > Pilih [3] Category > Namakan 

[4] Schedule > Klik [5] OK. 

   

 

[1] 

 
 

[2] 

 

 

[3] 

 
 

[4] 

 

 

[5] 
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Aturan dan keterangan bergambar 

ii) Pilih [6] untuk menentukan atribut/parameter > Klik [7] untuk 

memasukkan atribut/parameter yang telah ditentukan > Klik [8] OK. 

 

b) Mengemaskini Schedules/Quantities 

i) Pilih [1] untuk membuka paparan yang perlu dikemaskini > Klik [2] Edit 

untuk mengemaskini atribut/parameter > Klik [3] Add parameter untuk 

menambah atribut/parameter > Klik [4] Remove parameter untuk 

mengeluarkan atribut/parameter > Pilih [5] Sorting/Grouping untuk 

mengemaskini susun atur atribut/parameter  > Klik [6] OK. 

   

 

 

 

 

 

[6] 

 

 

[7] 

 

 

[8] 

 

 

[1] 

 

[2] 

 

 



BIM: MPT JKR Revit Mekanikal                                                             

40 
 

Aturan dan keterangan bergambar 

   

 

c) Eksport schedule/quantities 

i) Klik [1] File > Pilih [2] Export > Pilih [3] Reports > Pilih [4] Schedule 

> Namakan [5] fail > Klik [6] Save 

  

 

6.3.4 Sheets 

Sheets merupakan paparan bagi menjana lukisan yang telah dibangunkan  

daripada Views, Legends dan Schedules. 

 

Sheets terbahagi kepada 2 bahagian; 

1. Dokumentasi 

2. Bomba 

 

 

 

 

 
 

[3] 

 

[4] 
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Sheets Fungsi 

Dokumentasi Memaparkan lukisan yang mengandungi perkara 

berikut: 

1. Senarai Lukisan 

2. Lukisan Pelan / Siling 

3. Lukisan 3D / Skematik 

4. Lukisan Perincian 

5. Nota Am 

Bomba Memaparkan lukisan mengikut tetapan keperluan 

Bomba 

Jadual 4 : Fungsi Sheets 

 

6.3.4.1 Menggunakan Sheets 

Aturan dan keterangan bergambar 

a) Menjana Sheets 

i) Klik [1] Sheet > Pilih [2] Titleblock > Klik [3] Load jika perlu import 

Titleblock baru > Klik [4] OK.  

 

   
 

 

 

 

 

[1] 

 

 

 

 

[2] 

 

[3] 

 

[4] 
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Aturan dan keterangan bergambar 

b) Mengemaskini Sheets 

i) Klik [1] untuk menentukan bahagian sheet dan jenis lukisan  > Klik [2] 

untuk memasukkan maklumat tersebut ke dalam lukisan > Klik [3] 

untuk memasukkan tajuk lukisan dan tarikh lukisan > Klik [4] Apply 

 

   
 

 

ii) Klik [1] Project Information > Pilih [2] untuk mengemaskini 

maklumat projek > Klik [3] OK. 
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6.3.5 Families 

Families menunjukkan senarai komponen mekanikal, annotation dan title 

block yang terdapat di dalam templat. Semua families boleh digunakan dan 

diubahsuai semasa penyediaan model mengikut keperluan reka bentuk dan 

kesesuaian dokumentasi lukisan. Families boleh ditambah dan diperolehi 

daripada JKR BIM Library dari semasa ke semasa. 

 

 

Rajah 10 : Senarai family categories mekanikal 
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6.3.5.1 Menggunakan Families 

 

Aturan dan keterangan bergambar 

a) Menyemak senarai families 

i) Klik [1] untuk melihat senarai family yang terdapat di dalam templat > 

Klik [2] untuk melihat senarai family type yang terdapat di dalam 

templat 

  

   

b) Memuatnaik Family 

 

i) Klik [1] Load Family > Pilih [2] fail family > Klik [3] Open 
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Aturan dan keterangan bergambar 

 

c) Meletakkan Family 

 

i) Klik [1] Component > Klik [2] Place a Component > Klik [3] untuk 

melihat senarai families > Pilih [4] untuk menentukan jenis family. 

  

 

d) Mengemaskini Family 

 

i) Klik [1] pada family yang perlu dikemaskini > Klik [2] Edit Family 
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Aturan dan keterangan bergambar 

 

Mengemaskini Parameter 

ii) Klik [1] Family Type untuk mengemaskini parameter > Pilih [2] Type 

Name > Pilih [3] senarai parameter yang perlu dikemaskini > Klik [4] OK 
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[1] 
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Aturan dan keterangan bergambar 

 

Mengemaskini Connector Element 

iii) Klik [1] Connector Element > Pilih [2] senarai parameter yang perlu 

dikemaskini  > Pilih [3] senarai parameter yang perlu dikemaskini > Klik 

[4] Apply 

 

 

 

Connector Type 

1. Duct Connector 

a. Flow Configuration – Select from three values – Preset, System and 

Calculated, for measuring airflow in duct sizing 

b. Flow Factor – this percentage of system flow is used when the flow 

configuration is set to System 

c. Loss Coefficient – value becomes active when the loss method is set 

to Coefficient 

d. Flow Direction – sets the flow direction relative to the connector – In, 

Out and Bidirectional 

e. System Classification – default system values for supply / return / 

exhaust / other / global / fitting 

f. Pressure Drop – value becomes active when the loss method is set 

to Specific Loss 

g. Flow – default value assigned to the connector for air flow, and is 

included in the system properties. 

 

 

 

[1] 

 
 

 
[3] 
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Aturan dan keterangan bergambar 

 

2. Pipe Connector 

a. Flow Configuration – Select from three values – Preset, System and 

Calculated, for measuring fluid flow in pipe sizing 

b. Flow Factor – this percentage of system flow is used when the flow 

configuration is set to System 

c. K Coefficient – value becomes active when the loss method is set to 

K Coefficient 

d. Flow Direction – sets the flow direction relative to the connector – In, 

Out and Bidirectional 

e. System Classification – default system values for hydronic supply / 

hydronic return / sanitary / domestic hot water / domestic cold water / 

fire protection wet / fire protection dry / vent /  other / global / fitting 

f. Pressure Drop – value becomes active when the loss method is set 

to Specific Loss 

g. Flow – default value assigned to the connector for fluid flow, and is 

included in the system properties. 
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6.3.6 Revit Links 

Revit Links memaparkan model-model yang dihubungkan dengan model mekanikal 

bagi tujuan pembangunan model. Contoh model yang dihubungkan adalah seperti 

model arkitek, model elektrik, model struktur dan model sistem mekanikal yang lain. 

Pengurusan Revit Links perlu diambil perhatian yang sewajarnya agar model yang 

dihubungkan di dalam projek tersusun dengan lebih sistematik, mudah dikendalikan, 

difahami dan merupakan model yang terkini. 

 

6.3.6.1 Menggunakan Revit Link 

Aturan dan keterangan bergambar 

Menghubungkan model disiplin lain (Contoh : Link Model Revit Arkitek) 

 

i. Klik tab Insert [1] > Link Revit [2] (pada panel Link)  

 

 

 

ii. Pilih model Arkitek yang dikehendaki [3] untuk dihubungkan ke dalam 

projek. Klik [4] Open.  

 

 

 

 

[2] [1] 

 

[3] 

 

[4] 
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Aturan dan keterangan bergambar 

 

iii. Model Arkitek telah dihubungkan ke dalam projek [6] melalui Revit Links 

[5]. 

 

 

 

 

 

 

 

 

 

 

 

[6] 

[5] 



BIM: MPT JKR Revit Mekanikal                                                             

51 
 

6.3.6.2 Menggunakan Manage Link 

 

Aturan dan keterangan bergambar 

Menyemak fail model yang dihubungkan (Contoh : Link Model Revit Arkitek) 

i. Model yang telah dihubungkan boleh disemak di dalam tab Manage [1] > 

Manage Links [2] (pada panel Manage Project) 

 

 

Rajah 11 : Manage Links yang menunjukkan beberapa model yang telah 
dihubungkan 

 

Berikut merupakan fungsi setiap pilihan di dalam tetingkap Manage Links: 

a. Reload From... – Menghubungkan/memuatnaik semula fail model yang telah 

dikemaskini atau diubahsuai 

b. Reload – Menghubungkan/ memuatnaik fail model yang telah di’Unload’ 

c. Unload – Memisahkan fail model yang telah dihubungkan 

d. Remove – Membuang fail model yang telah dihubungkan 

 

 

 

 

[1] 

[2] 
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7 VIEW TEMPLATE 

7.1 Pengenalan View Template 

View Template mengandungi beberapa parameter paparan yang boleh ditetapkan 

mengikut keperluan model dan dokumentasi lukisan. View Template yang terdapat di 

dalam templat ini adalah seperti berikut; 

 

1. Floor , Structural, Area Plans 

a. jkrME_Plan_WIP 

b. jkrME_Plan_DOC 

c. jkrME_Plan_Bomba 

d. jkrME_Plan_Energy Analysis 

 

2. Ceiling Plans 

a. jkrME_Ceiling_WIP 

b. jkrME_Ceiling_DOC 

c. jkrME_Ceiling_Bomba 

 

3. Elevations, Sections, Detail Views 

a. jkrME_Elevation_WIP 

b. jkrME_Elevation_DOC 

c. jkrME_Section_Building 

d. jkrME_Detail 

e. jkrME_Callout 

 

4. 3D Views, Walkthroughs 

a. jkrME_3D_WIP 

b. jkrME_3D_DOC 

c. jkrME_3D_Coordination 

d. jkrME_3D_Bomba 

e. jkrME_3D_Export 

f. jkrME_3D_Energy Analysis 

g. jkrME_Views_Camera 

h. jkrME_Views_Walkthrough 

 

5. Rendering, Drafting Views 

a. jkrME_Plan_Drafting 

b. jkrME_Render 
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7.2 Fungsi View Template 

View Template membolehkan perekabentuk mempelbagaikan paparan yang 

dikehendaki dengan memilih parameter paparan berkaitan yang terdapat di dalam 

View Properties 

 

7.3 Penggunaan View Template 

Perekabentuk boleh menambah View Template yang baru sekiranya terdapat 

keperluan tambahan di dalam projek 

Aturan dan keterangan bergambar 

a) Mewujudkan View Template 

 

i) Klik [1] View Templates > Klik [2] Manage View Templates > Klik [3] 

Duplicate > Namakan [4] view template > Klik [5] OK 

 

  
 

  

 

 

 

 

[1] 

 

[2] 

 
[3] 

 

[4] 

 

[5] 
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Aturan dan keterangan bergambar 

 

b) Mengemaskini View Template 

 

i) Pilih [1] View Properties yang perlu dikemaskini > Klik [2] OK 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[1] 

 [2] 
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8 PARAMETER  

8.1 Pengenalan Parameter 

Parameter merupakan jenis data/maklumat yang ditetapkan di dalam fail komponen 

dan projek. Terdapat dua (2) jenis parameter iaitu Type dan Instance telah 

disediakan di dalam setiap family category.  

Maklumat parameter ini perlu diisi di dalam ruangan Value di sepanjang proses 

pembangunan model. Berikut adalah family category  yang terdapat di dalam templat:  

 

i. Project Information 

ii. Sheets / properties pallette 

iii. Views / properties pallette 

iv. Air Terminals 

v. Duct Accessories 

vi. Duct Fittings 

vii. Fire Alarm Devices 

viii. Mechanical Equipment 

ix. Pipe Accessories  

x. Pipe Fittings 

xi. Plumbing Fixtures 

xii. Sprinklers 

 

Di antara parameter yang terdapat di dalam setiap family category ialah maklumat 

geometri (panjang,tebal,lebar,tinggi dan lain-lain) dan maklumat bukan geometri 

(tarikh pemasangan,maklumat pembekal, jenis bahan dan lain-lain). 
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8.1.1 Type Parameter 

Type parameter membolehkan nilai bagi parameter di bawah kategori yang sama di 

ubah secara keseluruhan. 

Aturan dan keterangan bergambar 

Menyemak type parameter 

 

i. Klik [1]  komponen mekanikal > klik [2] Type Properties (pada panel 

properties)  

 

 

Rajah 12 : Contoh Type Parameter komponen hose reel 

 

 

 

[2] 

[1] 



BIM: MPT JKR Revit Mekanikal                                                             

57 
 

8.1.2 Instance Parameter 

Instance parameter membolehkan nilai bagi parameter tersebut diubah hanya secara 

berasingan dan unik untuk setiap kategori.  

Aturan dan keterangan bergambar 

Menyemak instance parameter 

 

i. Klik [1]  komponen mekanikal > semak [2] instance parameter (pada 

properties palette)  

 

Rajah 13 : Contoh Instance Parameter komponen hose reel 

 

 

8.2 Fungsi Parameter  

Terdapat dua (2) fungsi parameter iaitu :  

i. Membolehkan proses penyimpanan maklumat projek, rekabentuk, kuantiti 

bahan dan aset secara digital. 

ii. Membolehkan pengguna lain (Perekabentuk, Juruukur Bahan, Pengurus 

Projek, Kontraktor dan Pelanggan) mendapatkan maklumat yang berkaitan 

dengan model/projek untuk digunakan dalam pelbagai tujuan. 

 

 

 

 

[2] 

[1] 
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9 PRINT SETTINGS  

9.1 Pengenalan Print Settings 

Print Settings merupakan tetapan yang disediakan bagi mencetak lukisan yang 

dikehendaki.  

 

 

Rajah 14 : Contoh tetapan Print Settings 

  

 

9.2 Fungsi Print Settings 

Print Settings membolehkan perekabentuk memilih kepelbagaian paparan melalui Set 

Print yang disediakan. 
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9.3 Penggunaan Print Settings  

Aturan dan keterangan bergambar 

Memilih lukisan yang ingin dicetak  di dalam Print Settings (Contoh: Mencetak 

Lukisan Pelan Lantai) 

 

i. Terdapat lima (5) pilihan yang telah disediakan di dalam templat iaitu: 

 

a. jkrME_Print Layout Plan – mencetak lukisan pelan tapak dan pelan 

lantai 

b. jkrME_Print Lukisan Skematik – mencetak lukisan skematik 

c. jkrME_Print Section & Elevation – mencetak lukisan keratan dan 

pandangan 

d. jkrME_Print Details – mencetak lukisan butiran terperinci 

e. jkrME_Print All Sheets – mencetak semua lukisan  

 

ii. Pada Application Revit [1] > pilih Print [2] > pilih Print [3]. Klik Select [4] 

di bawah Print Range di dalam tetingkap Print. 

 

   
 

 

 

 

 

 

 

 

 

 

 

[2] 

[1]  

[3] 

 

[4] 
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Aturan dan keterangan bergambar 

 

iii. Pilih jkrME-01-Print Layout Plan [5] > ‘untick’ View [6] > tick pada senarai 

Pelan Susun Atur yang dikehendaki [7] > klik Save [8] > klik OK [9].  

  

 

iv. Pilih pencetak [10] yang dikehendaki untuk mencetak lukisan-lukisan yang 

telah di tetapkan di dalam Print Rage-Selected Views/Sheets [11]. 

v. Klik OK [12] untuk mencetak lukisan.  

 

 

  

 

[6] 

[8] 

 

[5] 

[7] 

 
[9] 

 

 

 

[10] 

[11] 

[12] 
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